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1 Introduction to DVD Ripper Platinum

1.1 Welcome
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Welcome to DVD Ripper Platinum! Thank you for purchasing this product. It is an all-in-one DVD
backup and ripping tool, which helps to convert the audio and video files on a DVD disc into other
formats, including AVI, MPEG, WMV, DivX, RM, MOV, MP4,MPEG-4 AVC,PSP MPEG-4 AVC,
3GP MP3, WAV, WMA, AAC, M4A, MP2, etc.

Meanwhile, it provides a good many of configurable parameters for audio and video file formats.
You can adjust parameters of object file such as bit rate, resolution and channels as you need. It
also allows the editing of ID3v1 and ID3v2 labels for WMA and MP3 audio formats. Moreover, it
allows conversion of specific clips/chapters on a DVD disc. The user can also choose required
channels, subtitles and angles.

DVD Ripper Platinum will bring you a more convenient watching and hearing enjoyment!

Supported sources
DVD-video discs
DVD file folders

IFO files
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Supported targets
Video

MPEG (mpg, mpeg, dat, vob); WMV; ASF; AVI; QuickTime (mov, qt); MPEG4 (mp4); 3GP; DV (dv,
dif); Real Video (rm); Animated GIF (gif - encoding only); Macromedia Flash (swf - encoding audio
only)

Audio

MPEG Audio (mp2, mp3); WMA; WAV; AU; MPEG4 Audio (m4a); Real Audio (ra); OGG; AAC
(aac); Raw AC3 (ac3); NUT Open Container Format (nut)

Supported codecs

Video codecs

3GPP - 3rd Generation Partnership Project (*.3gp);
3GPP2 - 3rd Generation Partnership Project 2 (*.3g2);
AVI - Audio-Video Interleaved (*.avi);

ASF - Advanced Streaming Format (*.asf);
Creative Zen Vision (*.avi);

Dell Axim X51 (*.wmv);

Dell Axim X51v (*.wmv);

DivX Movie (*.avi);

DVD-Video Format (*.vob);

General Pocket PC (*.wmv);

General Pocket PC-Excellent Quality (*.wmv);
General Pocket PC-Minimal Size (*.wmv);

HP IPAQ hw6500 series (*.wmv);

HP IPAQ hx2000/rx3000/rx1900 series (*.wmv);
HP IPAQ hx4700 series (*.wmv);

iPod (320x240) MPEG-4 Normal (*.mp4);

iPod Video (640x480) MPEG-4 Normal (*.mp4);
iRiver PMP-100 (*.avi);

MOV - QuickTime (*.mov);

MP4 - MPEG-4 Video (*.mp4);

MPEG-1 Movie (*.mpg);
Xilisoft Corporation,2007 Page 5



MPEG-2 Movie (*.mpg);

MPEG-4 AVC Video Format (*.mp4);

PS3 Video(1080P) MPEG-4 (*.mp4);

PS3 Video(480P) MPEG-4 (*.mp4);

PS3 Video(720P) MPEG-4 (*.mp4);

PS3 Video(480P) MPEG-4 Excellent (*.mp4);
PSP-PSP MPEG-4 Video (*.mp4);

PSP-PSP MPEG-4 Video-Excellent Quality (*.mp4);
PSP-PSP MPEG-4 Video-Minimal Size (*.mp4);
PSP AVC Video Format (*.mp4);

RM - RealVideo (*.rm);

VideoCD Format (*.dat);

VOB - MPEG2 PS Format (*.vob);

WMV - Windows Media Video (*.wmv);

Xvid Movie (*.avi);

Archos AV500/GMini402 (*.avi);

Archos AV700 (*.avi);

Super VideoCD Format (*.vob).

Audio codecs

AAC - Advanced Audio Coding(*.acc);

AC3 - Dolby Digital AC - 3(*.ac3);

M4A - MPEG-4 Audio (*.m4a);

MP2 - MPEG Layer-2 Audio (*.mp2);

MP3 - MPEG Layer-3 Audio (*.mp3);

OGG - Ogg Vorbis Audio (*.0gg);

RA - RealAudio (*.ra);

SUN AU Format (*.au);

WAV - Waveform Audio (*.wav);

WMA - Windows Media Audio (*.wma).
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1.2 Features

Converts DVD-video into other video format files

Extracts audio from DVD videos

Supports the conversion of the whole movie or certain title or chapter of a DVD
Converts any clip or segment by setting the start point and duration as you like
Supports the playing of DVD contents

Supports the modification of parameters for video and audio codec

Supports the editing of ID3v1 and ID3v2

Supports the viewing of parameters of original files

Supports the setting of the zooming mode for output movie

Supports the setting of the splitting mode for output movie

Supports the selection of audio tracks, subtitles and angles of output movie

Supports the setting of the name for output movie

vV Vv Vv ¥V V¥V ¥V ¥V VvV ¥V V VYV VYV V

Supports advanced settings, including audio, video, luminance filter, subtitle, DeCSS and
DVD-ROM cache.

Supports copy protection removal
Supports multi-threading and batch conversion

Supports multiple languages including simplified Chinese and English

Y VvV V¥V V

Supports skin change
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2 Install DVD Ripper Platinum

2.1 System requirements

Operating system - Windows NT/2000/XP/2003 or above
Processor - 750MHz Intel, AMD CPU or above
Available HD space - 100 MB or more

ROM drive - at least one DVD-ROM drive

vV V V¥V V V

Display - Super VGA (800 x 600) resolution or higher

2.2 Installation

Step 1: Download the installation package for DVD Ripper Platinum from http://www.Xilisoft.com.

Step 2: Double-click “x-dvd-ripper-platinum.exe” to start installation.

Step 3: Follow the instructions to finish the installation.

2.3 Uninstallation

Method 1:

DVD Ripper Platinum provides an uninstall function. By using it, you can easily delete all the files,
program groups or shortcuts created with DVD Ripper Platinum.

To do this, click “Start > Programs > Xilisoft > DVD Ripper Platinum” in turn, and then click the
“Uninstall item.

Follow the instructions to finish the uninstall.
Method 2:

Of course, you can also click the “Add > Remove Programs® in the Control Panel of your Windows
system, select DVD Ripper Platinum in the “Add/Remove Programs” window and then click the
“Delete” button to completely uninstall the program.
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3 Getting started

3.1 Starting the application

After installation of DVD Ripper Platinum, you can start the application by one of the following
methods:

Method 1:

Select the “DVD Ripper Platinum® program group in “Start > Programs> Xilisoft“ and then select
“Xilisoft DVD Ripper Platinum” option to start the application.

Method 2:

After installation, an icon with the name of Xilisoft DVD Ripper Platinum will be automatically
created on your desktop. Double-click the icon to run the application.

3.2 Quick start

Step 1: Load DVD

In the main interface, click the |E| button to load the DVD-video disc or DVD directory that you

wish to convert to the program list. In the pop-up dialogue box, select the DVD disc or DVD
directory that your wish to convert, and then click “OK” to load the DVD.

| * vilisodt DVD Ripper Plakinum kA
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Moreover, by selecting the “File > Add DVD Folder (Or Add IFO Files)” option or the “Add DVD
Folder (Or Add IFO Files)” in the right-click menu on the program list, you can also add DVDs to
the program list.

Hint: You can also import IFO files that you wish to convert into the program list by clicking the

=R

button.

Step 2: Check the programs that you wish to convert
After loading, all programs of the DVD are checked by default.

If you only wish to convert certain portion of the DVD, you can re-check the programs.

||

Moreover, by pressing the '———' button on the main interface, you can get all the titles of the

DVD and all the included chapters of each title displayed in the program list. Then, you can check
the chapters that you wish to convert in the program list.

| % ilisoft D¥D Ripper Plakinem - ox|
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o Tila_08_01 00019 1 WM - Mspect ko
Same Crasklty False
Ausdin
LT L 6
‘Sarnple Rate 44100
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Disable fudo  Falke
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For more information about the “' =" putton, please refer to the “Button bar” in “Operating

Instructions”.
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Step 3: Set the profile
After checking the programs that you wish to convert, you need to set the profile.

To do this:In the program list, select the programs that you wish to convert, and then select the
required format in the “Profile” drop-down menu on the main interface. The results will be
displayed in the program list.

See the figure below:

[ Saltsolt DD Ripper Plakinum -ox|
v Chapter 1 0-01:55 Pod Movie - jranm He Rt
o Chapber 2 il ah #Fod Hovie - Aspect Aako
o Chapter 3 45 Pod Hovie - Same CQuality Fagm
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o Chapter & e 56 Pod Hervis
v Chaptar 7 05 Pod Herie & Rt ol
s Chagbar & [ isi e Pod Hande - Sarighe Rate H1m
o Chiapbar 9 [ st ALk Pod Marvis - Chaaraneks 2
o Chapber 10 irs s Pod Marde - Disable Budo Faise
L Chapter 11 Q0z:47 Pod Mervie - —TT
* Chapter 12 el 10 P Flervim -
v Chapter 13 Ol 14 P Mervie
o Chaspler 14 Qi 30 Pl Mervie
o Chaptar 15 S04 Pl Merie
o Chaspher 16 Ol 58 P Mervia s
o Chapter 17 o065 35 P Hards : i
r— f— — p— — pr— f—
i ovo [ ] LLLL R =] 2 = n []
Proffils: li’bd [I20TA0MPEG-4 Norrnal (*.mpd ) we | Sawn A, || T
T Lt b R Splt= | Infirbe w | Configuns
HDD  1:11:51 022342
[estination: | C:ltemp Eroema,,. Oper,.. L}
i Ml v v.v w.o,

Hint: By repeating the previous operation, you can set different profiles for different programs.

For more information about “Profile”, please refer to the “Supported profile” in “Set Profile”.

Step 4: Adjust profile properties

After selecting profile for the program, you can adjust properties of the selected profile in the profile
property list on the right side of the main interface.
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Hint: For video formats, you can set their codec, video bit rate, resolution, frame rate, etc. For
audio formats, you can set their audio codec, audio bit rate, sampling rate and channels, etc.
Meanwhile, you can also choose a segment of the selected program and convert it. As for WMV,
WMA and MP3, you can edit their ID3 labels for the output files.

For more information about “Profile property list”, please refer to the “Common output property list”
in “Set Profile”.

Step 5: Set the Destination

Set the path that you wish to save the output programs. You can set the “Destination” in output
control panel on the main interface to save the converted files. You can also set the “Zoom” and
“Split” for the output files on the output control panel.
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Step 6: Start the conversion

After setting, click the ! o button on the main interface to start the conversion of the programs

checked in the program list. During conversion, you can track the conversion progress in the
program list until the end of conversion.
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Moreover, during conversion, you can click the '——' button on the main interface to pause the

(m |

conversion, or the '——' button to stop the conversion.

Step 7: Finish conversion

After the conversion is done, click the l@ button on the main interface to open the

Destination and view the conversion results.

Hint: DVD Ripper Platinum has a built-in “PSP Video Manager” function. After conversion, you
can easily import PSP video files into PSP devices.

For more information about the “PSP Video Manager”, please refer to the “Main Menu>Tools
Menu” in “Operating Instructions”.

If the output file is in iPod MP4 format, you only need to click the |_“P#M* | putton and, in the

Destination, copy or drag the required files into your iTunes.

3.3 How to configure DVD source file control panel

Step 1: Run DVD Ripper Platinum, load a DVD-video disc or import an IFO file and then select
the programs that you wish to edit in the program list.
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Step 2: In the DVD source file control panel, set the audio, subtitle, angle, album and title for
output program. For example, in the “Audio” drop-down list, click the required audio to select it.
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3.4 How to customize “Profile”

Besides the “Profiles” provided by the software, you can also customize your own “Profile”
according to your needs. Moreover, you can save, rename and delete the custom “Profile”. To do
this:

Step 1: Run DVD Ripper Platinum, add and select the files that you wish to convert, select
“Profile” and then modify the properties in the output property list.

Step 2: After the modification, you can save the modified “Profile” in a customized manner. Click

the @ button on the main interface. In the pop-up dialogue box, enter a name for the

custom “profile”. Click “OK” to confirm the operation and close the dialogue box. At this time, the
custom “profile” will be added to the “Profile” drop-down list for future use.

Xilisoft Corporation,2007 Page 15



[ silisoft ovD Ripper Platinum R

Al s
R et | St Tas 00:00:00
- Hame Durstion  Chapters  Target ‘Stabus A | = videa
¥ Eif
o Title_01_1& OOH00:04 1 Pod Movie - Widen Size 320240
o Chapter 1 a0 Pod Hovie - 1500
v THenzon B4z W Podbove . i
v Chagter 1 00155 Pod Movie - o He pt
o Chapber 2 il ah #Fod Hovie - Aspect Aako
o Chapter 3 45 Pod FHovis - Same Quakty Faigm
w Chapber + alesil 7 PFod Hovie - = i
" Chapter § il 02 P Fovis -
o L] o i Pod Mavie -
2 s £ Rt 4
DR O ) | S
o Chapber 9 ‘Channets 2
5 Chapter 10 Plsass sntar the name:; Disable fudo  Fale
» Chapter 11 — !
= s | [Pt tz20a4cimpec4 ool ERINERR Coneel 3 Fate
o Chapber 14
o Chapber 15
L Chapber 16 el 50 P i
w Chaapler 17 Coes: P Miria
oV a e BEE s . lom -,
Frofie: Pod (ID0ANMPEG Normal (*.mpd )
T Lt b - Splt: | Infire
00 00 ST D01 :55
Dmestination: | C:ltemp Eroera,,. Opar,.. ¥
e e C S IO

Moreover, selecting the custom “profile” and you can carry out operations on it by clicking the B
button on the main interface and selecting the “Save”, “Rename” or “Delete” options in the

popped-up drop-down menu.
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3.5 How to set the Destination

Step 1: Run DVD Ripper Platinum, load a DVD-video disc or import IFO files and then select the

programs that you wish to convert in the program list.

[ silisoft ovD Ripper Platinum
Eddit.

= General - |
D ation Ful
Sttt Ty 00: 000
Target
- Wideo
Srandard Ato
Wideso Sizer J20040

Ervghsh D75 éch (D88 w { hore: -
A [ et | Chagter §
b e Duration  Chaplers Target Srabus -
w Eif MPEG-]
e Tk _00_1& e e nH L] 1 MPEG-1
L Chapher 1 H HPEG-1
+ Tile 02 01 3 HPEG-1
€ huapite =
v Chapber 2 HPEG-1
o Chapter 3 3 MPEG-1
o Chapter 4 i MPEG-1
o Chapter § 3 HPEG-1
o Chapber & - HPEG-1
o Chapber 7 3 HPEG-1
- Chapter & : MPEG-1
o Chiapber 9 = HPEG-1
b Chapter 10 i ] HPEG-1
L Chapber 11 2 b HPEG-1
L Chapber 12 a0 HPEG-1
L Chaapber 13 eG4 HPEG-1
L Chaspber 14 30 MPEG-1
L Chapber 15 s HPEG-1
L Chapter 16 e 50 HPEG-1 =
L Chaapber 17 el 38 HPEG-1 . e
1 r— — Y —
I ove ||| B o [ B8 e |~ n ™
Profils: MPEG-1 Mavie (*.mpg) w | Savs A ||
T Listhisr b - Splt= | Infardbe w | Configurs
| |Dn~:mm- Ciltamp Erowna,,. e, 1

L e el L

KRR R O

Step 2: In the Destination editing box of the output control panel, set the required path to save the

output programs. In addition, you can also click the button, and select the required

path from the pop-up dialogue box.

Xilisoft Corporation,2007

Page 17



[ alisoft DVD Ripper Platinum oo
Edit

Ervgksh 0TS éch {088} w Hore w 1 = General |
....... o Drakion Ful
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w e | = Summary
v E Tl
o Titde 0 _1& Augthor
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v Tiths_02_0 Commants
o Chapter 1 =
z Chapter & pessaee - Ak
o Chapter 3 ] _j My Distusnnis A
o Chapter 4 = N My Compaker Compaser
| : ”""""3 & S Local Disk (C2) i, Artist
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v c 8 L B DD g Ersoad by
v Chagter 9 ) mus Year
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- Cheapter 11 # W My Network, Places oy T
W Chapter 12
- Chapter 13 = fasdio pr
" Chapter 14
o Chaplar 15
o Chapber 16
o Chagter 17 [
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3.6 How to view the conversion result

Step 1: Run DVD Ripper Platinum, load a DVD-video disc or import IFO files, check the

programs that you wish to convert, select required profiles, and then click the L button to

convert the checked programs.
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7 xailisoft D¥D Ripper Plakinum = 0%
Edit;
Ervghch DTS éch {OwBE) W Hore w = General |
¥ Dration Full
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Step 2: After the conversion is done, please click the button on the output control

panel to view the result in a pop-up file folder.
[ alisoft D¥D Ripper Platinum -ax
Edit:
Ervghch DTS &ch {OxBE) w Hore L = General |
.................. Durakion Ful
i R choctr & StwkTs 00000 |
W Duration Chaphers Target Shasburs A= Widen |
Ef
Tile_01_18: £xz04 1 MM - Viden Size e |
Chapber 1 o rsaofil] HES - |
fitke_02_01 ez M M - oLate o
o Chapber 1 055 ] Coemplsted Frame Rabe Auko {
v Chaptar 2 008 s Complsted Aspect Auto |
e Chapter 3 Ol 45 il opmplsted S Quakty Falgm |
| Chapter 4 [ ke sl Compisted = fandin
| Chapter § [ e H HPg ot |
o Chispbar & [ 254 e el & Rate 125 |
™ Title_02_01 SwvglRate 48000 |
Fie Edt Vew Favorkes Took  Hep Channets 2 {Stereo)
; T Dissble fudo False |
Qs - © - F Powa |2 '
akiness | Cr\bemphE-=1Tile_0Z_0I
Foder§ & @
= I bemp . m'::.
= 3 E-
P £ Tl 22 01 e
B WINDOWS .
P & < vocal sk (0) L“u
Zoom| & () CASTAWAY (ES) ¥ Cupher
¢ » 4.mpA
_mﬂim: MPEGH Madis Sze: 10,9 M8 18.59 MB
Hint: During conversion, you can also click the button to view the conversion.
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3.7 How to preview programs

Step 1: Run DVD Ripper Platinum, load a DVD-video disc or import an IFO file, select the
programs that you wish to convert in the program list, and set the profiles.

- I D akion Full
Al | T
) o2 01 St Tere 000000
b e Duration  Chaplers Target Stabus o Tar gt
¥ Eff = Wideo
L Tk _00_18 e iei nH iz ] 1 HPEG-1 =
1 O MPEG ] - Sanderd Auto
LT E : =2] o -
v Chapter 1 0001355 MPEG-1 - PREs ]
v Chapber 2 Db HPEG-1 - Bt Rate 160
o Chapter 3 il 45 MPEG-] - Frame fLabs 25
w Chapber + ST HPEG-1 - fapact fakn
o Chaptar § 02 HPEG-1 -
v Chapter & 00156 MPEG-1 . _ Suie Gty Fekie
v Chaptar 7 (305 MPEG-1 . Audio
v Chaghar & [ isitre HPEGC-1 - Al i gl
o Chiapbar 9 [ s EL k] HPEG-1 - &t Rate 1az
- Chaptar 10 (0380 HPEG-1 . Sarplemate 44100
L Chapter 11 Q0z:a7 MPEG-] - S
Es Chapter 12 Q410 MPEG-1 -
w Chapter 13 o014 MPEG-1
o Choaper 14 D039 MPERG-1
o Chaptar 15 0504 MPEG-1
L Chapter 16 0E 50 HPEG-1 -
L4 Chaapler 17 O 30 HMPEG-1 - !
T — pr—— p— [, o, [— ——
} o ||| [ LU TR 7] & =i n ]
Profile: MPEG-1 Mavie (*.mpg) w | San AL ||
I
Toait Lt w sple: | Tnfirde w | Corfigre... || i
| Dstinations | Ciitamp Browa.,. Opery... o
| M G e wA,

)
Step 2: Click the {—) button on the player to preview the selected program. You can also use the

“Move to start”, “Move to end”, “Backward”, “Forward” and “Jump” buttons to set the playing
position.
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[ alisoft DVD Ripper Platinum = 0%

Edil;
Ersghsh DTS sch (0nB8) w Hore - 1 w || = General |
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Hint: If you wish to locate an exact position, you can click the EE}: button and, in the pop-up
dialogue box, enter the time point to jump to, as indicated in the following figure:

Jump X

Jump tao {range From 00:00:00 bo 00:42:11)

|n|:|:|35:24 |

[ Ok ] [ Cancel ]

After setting, click the button to close the dialogue box. Meanwhile, the player will

play the selected program from the selected time point.
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4 Operating Instructions

4.1 Interface layout

2 0%

adbiithe:  Prglsr = General
Durakion Ful
i Skt Tives 00:00:00
e Durstion  Chaphess Tanget Seabus = Widen
Wikt Codle h2s3
Getting Started Wides Size 176t 44
it Rate 120
1 ©lick *Profile” combobox to choose & profile Prome fabe i
2. Chek "IN Batban 1o open DVD Aspect At
3. Click *Rip” button to stam rpping Bitrate Tolersnce 60
S Cuallty Fginm
® - o
Fufy Cioadin ami_rb
Py Rt Rt 48
H | Sample Rate BOOD
Channels 1 {Mona)
Dtsable Budo Faise:

Profils: 3GPP « Trd Gt SO0 Padtns P . w o S,

T Listtesrbas :-.:‘ HS:lell:-‘m @ W oo |::'l

Dmstinations | Ciitamp Erowra.,. Cpaani.. W

Raady (5) gl MR R RO

1 Main menu Provides menu items such as File, Edit, Settings, Tools
and Help.

2 DVD source file control panel | In this area, you can set the audio, subtitle, angle, album
and title for the DVD source file.

3 Program list Displays information about the loaded DVD and the
conversion status.

4 Button bar This area provides “Open DVD”, “Open IFO file”, “Edit”,
“Hide Chapters”, “Start ripping”, “More ripping options”,
“Pause ripping” and “Stop ripping” buttons.

5 Output control panel In this area, you can set the profiles, zooming modes,
splitting modes and destinations of output programs.

6 Status bar Displays information about the programs and the
progress of conversion, and offers the function of log
view.

7 Output property list In this area, you can modify general properties, audio
properties, video properties and ID3 label of profile.

8 Preview player In the area, you can play a selected program.
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4.2 Main menu

421 File menu

File Edit | Settings | Tools | Help

Add DVD Folder...
Add IF0 Files...

Exit

Add DVD Folder

Click to open the “Select DVD file” dialogue box. Then select the required DVD disc or DVD folder.
After loading, all programs of the loaded DVD will be displayed in the program list.

Add IFO Files

Click to open the “Select IFO file” dialogue box. Then select the required IFO file. After importing,
all programs of the imported IFO file will be displayed in the program list.

Rip All Checked
Click to start the conversion of all the checked programs in the program list.
Pause All Checked

During conversion, click the “Pause All Checked”, the conversion of all the checked programs in
the program list will be paused.

Stop All Checked

During conversion, click the “Stop All Checked”, the conversion of all the checked programs in the
program list will be stopped.

Rip Selected
Clicking the item will automatically check and convert the selected programs in the program list.
Pause Selected

During conversion, clicking the “Pause Selected” item will pause the conversion of the selected
programs in the program list.

Stop Selected
During conversion, clicking the “Stop Selected” item will stop the conversion of the selected
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programs in the program list.
Exit

Exit the application.

4.2.2 Edit menu

File I Edit Settings | Tools | Help

Select All Children

In the program list, select a required program. Click “Select All Children” item, all its children
programs will be selected.

Select All

Select all the programs in the program list.

Rename

Rename the title of a selected program in the program list.
Remove

Remove the selected program from the program list.
Clear

Clear the program list.

Check

Check a selected program in the program list.
Uncheck

Uncheck a checked program in the program list.
Check All Children
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In the program list, check a required program. By clicking “Check All Children” item, all its children
programs will be checked.

Check All

Check all the programs in the program list.

Uncheck All Children

Uncheck all the checked children programs of a selected program in the program list.
Uncheck All

Uncheck all the checked programs in the program list.

4.2.3 Settings menu

File | Edit I Settings Tools | Help

Change Skin...

Language [

Preferences...

Change Skin

Open the “Change Skin” dialogue box to select the desired skin for the software.
Language

Click the “Language” item and then select the desired language from its submenu.
Preferences

Open the Preferences tab, where you can modify the preferences for the application and you can
also set the properties for DVD source files, such as audio, video, luminance filter, subtitle, DeCSS
and DVD-ROM cache.

For more information about the setting, please refer to the “Preferences tab” in “Operating
Instructions”.

424 Tools menu

File | Edit | Settings i Tools Help

‘ PSP Yideo Manager |

PSP Video Manager

Call PSP Video Manager, by which you can import the video files that has been converted to the
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PSP format to PSP device.

o PER Vikden Manager
i Hiwe-i
i Cinpap-s
Hoar
L 1

425 Help menu

Ele | Edit | Settings | Tools -
= = = —_________}

LContents

Buy Regiztration Code
Enter Registration Code...
Feedback and Support

About. .

Contents

Open the help file.

Buy Registration Code

Open the web page where you can buy a registration code for this software.

Enter Registration Code

Open the registration dialogue box, where you can enter the registration code for registration.
Feedback and Support

Access the website of Xilisoft Support Center.

About

Open the “About” dialogue box; you can view the information about copyright, version and
registration of the software there.
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4.3 Preferences tab

By clicking the “Preferences” item in the drop-down menu of “Settings”, you can open DVD Ripper
Platinum’s Preferences tab, as indicated in the following figure:

Preferences E|
General | DYD (Global)

Rip
Macinum simultaneous processes: [

Mazimunn sinultanecus running processes: I

[#] skip checked title: in chapter mode

Previeve
Previews window aspect ratio: 213 &P

[#]Enable vides while plaving Rendering: |YUY v
[#] Enable audio while playing

Ctput

[#] Create chapter Folder in output Folder
[#] Create abum Folder in output Folder

i OF H Cancel ]
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4.3.1 General

General | DYD (Global)
Rip
Maximun simultaneous processes; m"

IMacdmun simultaneous running processes: 1

[#] skip checked title: in chapter mode

Previews

Previews window aspect ratio: 213 &P

[#]Enable vides while plaving Rendering: |YUY v
[#] Enable audio while playing

Ctput

[#] Create chapter Folder in output folder
[#] Create abum Folder in output Folder

[ OF || Cancel ]

Rip
Here you enter a number respective for maximum simultaneous processes and maximum

simultaneous running processes for DVD Ripper Platinum.

Note: By setting the maximum simultaneous processes and maximum simultaneous running
processes, the multi-threading technology can be used to increase conversion efficiency of the
software.

Hint: The number should not be too large. If it is too large, considerable time will be spent on
process scheduling, leading to efficiency decrease. Besides, the maximum simultaneous running
processes should be equal to or less than the maximum simultaneous processes.

By default, the maximum simultaneous processes = 10; the maximum simultaneous running
processes = 1.

Meanwhile, you can also set “Skip checked title in chapter mode” in the tab.

If the checkbox is checked, checked titles would no longer be converted. Otherwise, checked titles
would be converted.

Note: Chapter mode refers to the display mode in which the title and all its chapters are displayed
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in the program list.

For more information about the “Chapter mode”, please refer to the “Button bar” in “Operating
Instructions”

Preview

Preview window aspect ratio

Set the aspect ratio for the preview window. Two options are available: “16: 9” and “4: 3”.
Rendering

Select the rendering method for the video being played in the preview window. Two options are
available: “YUV” and “RGB”.

Meanwhile, you can also decide whether to play video or audio while playing the program.

Output

Here you can determine whether to create chapter folder and album folder in the output folder
while setting output programs.

4.3.2 DVD (Global)

Preferences @
General| DYD (Global)

Video #udio
Cutput Frane Rake: Downsamphng:
N | |t downsamgling -
[#] Detact progressive 24 Hz

P
[ Force progressive 24 Hz | m

[#] Dalbry Surround
[[] Audio | Widen syncheonisation
Deinterlace Fiker: Interpolate P Save your CVD drive
iDCT: Slze (MB): o
S5E2 (Inkel P4) “ Locaian: RAM |
DeCss Luminance fiker
CJuse asp1 DieMacrobision [Clenable
Fey search: Gain: 126
Each V0B 1D ~ | Offset: 0
Subtitle
Offset {pial): o
[+#] Original eolors

[ ox | l Cancel I
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Video
Output Frame Rate

Set output frame rate for video files. Five available options: “Keep original”, “23.976(NTSC)", “24”,
“25(PAL)”, "29.97(NTSC)”, “30".

Hint: DVD Ripper Platinum will not automatically set this option. If you set a frame rate different
from that of the source program, the converted program will have the set frame rate. Besides,
please avoid the conversion between different television systems, such as conversion between
NTSC and PAL, or between PAL and NTSC.

Default: Keep original
Detect progressive 24Hz

Automatically detect progressive 24Hz sources. Detected source frame rates will be displayed in
the main interface.

Default: checked
Force progressive 24Hz
Force the source to be a progressive 24Hz source

Hint: The “Force progressive 24Hz” box is only checkable when the “Detect progressive 24Hz”
box is checked.

If you think the detection result incorrect, you may consider checking the option.

Default: unchecked

Audio/Video synchronization

If this box is checked, audio and video signals will be synchronized again according to the cycle.

Hint: if you have selected values different from the source program in previous options, please
check the box to ensure audio/video synchronization of the output program.

Default: unchecked
Deinterlace Filter

If the source program is interlaced, while you wish to deinterlace to generate a progressive
program, please check the box.

The interpolation (interpolating even field) will definitely work. However, it will also compromise
some picture quality when making formats such as SVCD.

Default: Interpolate
iDCT
Set Inverse Discrete Cosine Function Transform.

MMX is the fastest and is suitable for most CPUs, while FPU provides the best quality.
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Default: Automatic detection of local CPU

DeCSS

Simply leave the original default value for DeCSS unchanged. It needs the installed ASPI to
perform drive authentification and read files over 1GB in a DVD.

If you get a confused video, please try to change the mode for Key Search.
Key search

Set the mode for CSS key search.

Default: Once

DeMacroVision

Check the box to remove the macro vision protection of the movie.

Default: checked

Subtitle
Offset(pixel)
Set the pixel offset in vertical direction for subtitles.

If the subtitle is displayed outside the screen area, DVD Ripper Platinum will automatically adjust
the value for the option.

Default: 0

Hint: When setting “Offset” values, a positive value indicates a downward offset, while a negative
value indicates an upward offset.

Original colors

Check the box to keep the original subtitle color.

If the original subtitle is too dark, please do not check the box.
Default: checked

Besides, you can also determine whether to keep the original color of a subtitle. If the original
subtitle is relatively dark, it is recommend that you don’t need to keep original colors.

Audio
Downsampling
Note: DVD audios generally have a sample rate of 48000Hz or 44100Hz (with certain exceptions,

Xilisoft Corporation,2007 Page 31



of course), while actually such a high sample rate is not necessary for most of the times
(meanwhile, certain devices do not support ultra high sampling rates). Therefore, you can
decrease the sample rate by downsampling. Downsampling can be realized together with bit rate.
Of course, the bit rate can be kept unchanged during downsampling.

Downsampling provides the following modes:
Normal quality 48.0KHz to 44.1KHz (fastest)
High quality 48.0KHzto 44.1KHz (very slow)
No downsampling

44 1KHz (no conversion) -- If your source program has a 44.1KHz audio, and you wish to keep the
rate unchanged after conversion, please select this mode.

48.0KHz (no conversion) -- If your source program has 48.0KHz audio, and you wish to keep the
rate unchanged after conversion, please select this mode.

Default: No downsampling

Volume

Set volume for output audio.

For most DVDs, the default volume is already sufficient.

Besides, you can use the Detect button at the right side of the Volume option to detect the real
time volume of source DVD. For example, you can detect a clip that you think it has a high volume
and, according to the obtained volume value, enter a proper value for the Volume option.

Default: 3
Dolby Surround
If the box is checked, the better 5.1FX will be maintained in the stereo.

Default: checked

Save your DVD drive
Set an amount of temporary buffer cache to avoid frequent read/stop of DVD-ROM.

Typically RAM will be set as temporary buffer cache so that the conversion will be faster. Of course,
you can use hard disk space as temporary buffer cache.

Typically, files will be saved in a temporary system directory. Therefore, before conversion, please
make sure that there is available temporary directory.

Default: Cache size = 10MB; location = RAM.
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Luminance filter
Set luminance of the program.
If the box is checked, luminance rendering will be used.

Hint: use luminance filter to modify the gain value. If the gain is less than 128, the image will
become darker; when higher than 128, it will become lighter. (Typically gain values are multiples of
64, for example: 0 = 0.0; 128 = 1.0; 256 = 2.0)

The Offset is based on the gain.

Default: unchecked (i.e., gain: 128; offset: 0)

4.4 DVD source file control panel

Audin: Subkitle: angle:

Alburn: Title:

In the DVD source file control panel, you can set the Audio, Subtitle, Angle, Album and Title for
DVD source files.

Audio

Select the audio that you wish to convert for a selected title or chapter.
By default, the first option of the drop-down menu is selected.
Subtitle

In the drop-down menu, select the required subtitle, which will be the output subtitle for a selected
title or chapter.

By default, None is selected.

Angle

Select the required shooting angle for a DVD.

Note: The angle only applies to selected titles.

Most of the movies are saved in angle 1.

By default, 1 is selected.

Album

Edit the name of your favorite album.

Hint: The Album option only applies to selected DVD-ROM root directory.

By default, it is set as the DVD-ROM drive letter.
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4.5

4.5

Title
Set the desired title name as the output title for the selected title or chapter.

If neglected, the default source title name will be the output title name.

Program list

o Marmne Dwration Chapters Target Skakus
v Eil
W Title_D1_16 00 00: 04 1 MPEG-1 -
W Chapter 1 00004 MPEG-1 -
v Title_02_01 02:23:42 33 MPEG-1 -
W Chapter 1 00155 MPEG-1 -
v Chapter 2 00:06: 46 MPES-1 -
W Chapter 3 000345 MPEG-1 -
b Chapter 4 00517 MPEG-1 -
W Chapter 5 o002 MPEG-1 -
v Chapter & 00:01:56 MPES-1 -
W Chapter 7 000305 MPEG-1 -
b Chapter & 0n:05:25 MPEG-1 -
W Chapter 9 000443 MPEG-1 -
v Chapter 10 00:03:40 MPES-1 -
W Chapter 11 oD:0z:47 MPEG-1 -
b Chapter 12 000410 MPEG-1 -
W Chapter 13 o014 MPEG-1 -
v Chapter 14 00:04:39 MPES-1 -
W Chapter 15 000504 MPEG-1 -
b Chapter 16 000258 MPEG-1 -
W Chapter 17 ;0 35 MPEG-1 -
.1 Header
W Mame Dwuration Chapters Target Skakus
CheckBox

Dialogue box is checked to determine the programs that you wish to convert.

Name

Displays the name of the root directory of a loaded DVD and names of all its programs
Duration

Displays the playing durations of all the programs of a loaded DVD

Chapters

Displays the number of chapters contained in a title

Target

Displays the conversion format for a program

Status
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Displays status of a program during conversion

The status of a program includes: Finished, Paused, Waiting, Waiting to resume, No status, Stop
and Running.

4.5.2 Right-click menu

When using DVD Ripper Platinum, you can also use the right-click menu to perform
common-used actions. Right-click your mouse at any location of the program list and a right-click
menu pops up.

W T Dration Chapters Target Skakus L
v B

Title_01_16 MPEG-1 =
v Chapter 1 Add DYD Folder... MPEG-1 -
v Title_02_01 Add IFC Files... MPEG-1 -
v Chapter 1 MPE=-1 -
v Chapter 2 Remove Del MPEG-1 -
W Chapter 3 Clear MPEG-1 -
v Chapter 4 MPE-1 -
v Chapter 5 Rename Fz MPEG-1 -
v Chapter & MPE-1 -
v Chapter 7 Check MPEG-1 -
v Chapter & Uncheck MPEE-1 -
v Chapter 9 ] MPES-1 -
v Chapter 10 Check All Children MPEG-1 _
v Chapter 11 Check Al MPE-1 -
W Chapter 12 UnCheck All Children MPEG-1 -
W Chapter 13 Unicheck Al MPE-1 -
v Chapter 14 MPES-1 -
v Chapter 15 Select all Children MPEG-1 -
v Chapter 16 Select Al el MPEG-1 -
W Chapter 17 i MPEI-1 - bl

Rip Selected

Pause Selected
Stop Selected

Properties...

Using the menu, you can easily carry out regular operations.

Moreover, when right-clicking on a selected title or chapter, the Properties item becomes available.
For example, select Title_01_16 and right-click to open the menu. Select the Properties item, and
the Title properties dialogue box for Title_01_16 will pop up.
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Title Properties

Properties |
Title Infa
Resolution: [
Frame FLate: :29 97 fps
Aspect Ratio: [4:3(1.339)
Audo Samgle Frequency: 4000 He
Video Audio
Frame Rate:  Keep original v Downsamping:
[#] Detect progressive 244z Ne dewnisamping hd
[CIFarce progressive 24Hz e
Deiterace Fiter: | Interpolste v :’ 0
[l dudio  Videa synchronisation
Subkitle Luminance: Filker
(® Original colors () Black and white Clenable
f Gain: (]
Offset (Picels): 0
' Offset 0
[ Apsphy to ol chapters in this bt
CoJ e

For more information about the “Parameters on Title Properties”, please refer to the “Preferences
tab” in “Operating Instructions”.

4.6 Button bar

s (o ) TR (=] le @ Cu ) Ca]

——'“Open DVD” button

Add a DVD-video disc or a DVD folder that you wish to convert to the program list.

=R “Open IFO files” button

Add IFO files that you wish to convert to the program list.

TITLE

. J*“Edit” button
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Click the Edit button. In the pop-up drop-down menu, you can select various editing functions of
DVD Ripper Platinum, as indicated in the following figure:

Remove Dl
Clear

Renarme F2
Check,

ncheck

Check all Children
Check all

nCheck all Children
ncheck Al

Select All Children
Select Al Chrl+A

= | “Show/Hide Chapters” button

Click the button to show/hide the chapters under a title.

Note: when 85 is displayed, the chapters will be shown.

When ="/ is displayed, the chapters will be hidden.

® “Start Ripping” button

Clicking the item will start the conversion of all the checked programs in the program list.
=) “More Ripping Options” button
Clicking the button, a drop-down menu pops up.

In the menu, more ripping options are available as indicated in the following figure:

Rip Selected
Pause Selecked
Shop Selected

Rip &l Checked
Pause All Checked
Stop All Checked

= Pause ripping

Stop ripping
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4.7 Output control panel

Profile: Archos AW7F00 (. awi) W ||Save As... ||=
Zoor: Full (keep aspect ratio) w Split: | Infinite w || Configure. ..
Deskination: |Diydocumentsitestivideo Browse, .. CIpEM. .\

In the output control panel, you can set the output format, zooming mode, splitting mode and
destination for output programs. Moreover, you can manage custom profiles and view the directory
where the files are saved.

Profile
Select a profile for the output program in the drop-down menu.

For more information about “Profile”, please refer to the “Supported profiles” in “Set Profile”.

Save As
Click to open a dialogue box where you can save your custom profiles.

Besides, select a custom profile in the drop-down menu and click the drop-down button at the right

Save...

side of to open its drop-down menu, as indicated in the following drawing:

Save
FRename
Delete

Save: save your custom profile
Rename: rename your custom profile
Delete: delete your custom profile

Hint: The three operations only apply to custom profiles.

Zoom

Select the zooming mode for output programs, as indicated in the following figure:

Mediurn
Pan and Scan
Full (keep aspect rakio)

Letterbox: add black stripes at both sides of the source program
Medium: cut the source program while adding black stripes

Pan and Scan: cut the source program
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Full: stretch the source program

Split

Select a splitting mode for the output program in the drop-down menu, as indicated in the following
figure:

B50ME Recordable CD
TO0ME Recordable CO
S00ME Recordable CD
4,7GE Recordable DYD
Custom size (100,00 MB)
Cuskom ke (00: 10:000

Infinite: output according to duration of the source program

650MB Recordable CD: split the source program with the maximum size of a single output file
being 650MB

700MB Recordable CD: split the source program with the maximum size of a single output file
being 700MB

800MB Recordable CD: split the source program with the maximum size of a single output file
being 800MB

4.7GB Recordable DVD: split the source program with the maximum size of a single output file
being 4.7GB

Custom size: split the source program according to custom size; maximum size of a single output
file is defined by the user

Custom time: split the source program according to custom duration; maximum duration of single
output file is defined by the user

Default: No splitting

Destination
Set the destination directory where the output files are saved

For more information about the “Destination”, please refer to the “How to set the Destination” in
“Getting started”.

Open
Click to open the folder where output files are saved and view the results of conversion.

For more information about the Open button, please refer to the “How to view conversion result” in
“Getting started”.
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4.8 Status bar

Frame=208 q=0.0 size=1950kE time=F.8 hitrate=2344, Zkhits/s E

During conversion, through the status bar, you can easily view the information about the program
that is currently being converted.

Moreover, by clicking the E button at the right side of the status bar, you can open the Log

dialogue box and view the conversion log for a selected program, as indicated in the following
figure:

Input #0, ifa, from 'EXAVIDED_TSWTS_01_0.IFO"
Duration: 02:07:33.4, bitrake: 354 khj's
Sktream #0.0: Wideo: ifo_v, 720x480, 29,97 fps
Stream #0,1: dudio: ifo_a, 48000 Hz, steren, 354 kh)'s

Cutput #0, mpd, ko 'CHTemplE--1Title_01_01YChapter 1.mp4's
Skream #0.0: Yideo: mpegd, 320x240, 29,97 fps, 0=2-31, 512 kh/s
Skrearm #0,1: dudio: mpegd4aac, 44100 Hz, steren, 64 kh)'s

Streamn mapping:
Skream #0.0 -= #0.0
Skream #0.1 -= #0.1

Wideo: 23364kE Audio;5979kE Global headers:0kE Muxing overhead 0,760947%
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4.9 Output property list

= General
Durakion Full
Start Time 00:00:00
=l Summary
Title:
Buthor
Copyright
Carmmenks
Alburn
Genre
Composer
Crig. Arkisk
LRL
Encoded by
Year
105w True
= ¥ideo
Yideo Codec VT
Yideo Size 320x240
it Rate 1200
Frare R.ate Auko
Aspect Auta
Same Quality False
Disable video False
= Audio
Audio Codec WA T
Bit Rake 128
Sample Rate 43000
Channels Z (Sterea)
Disable Audio False
Disable Audio

After setting profiles for output programs, in the output property list that is located on the right side
of the main interface, you can further configure specific parameters for a selected profile. These
include general properties for audio and video formats, audio properties, video properties and ID3
label properties.

For more information about “Set output properties”, please refer to the “Common output property

list” in “Set Profile”.
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4.10 Preview player

Using the preview player, you can view a selected program in the program list.

an.00.00 00:21:19 00:42: 38

'._H‘.' '._»{.' |__. | |__« | '._».' '._E}.'
= = = = = =

“Move to start” button

Jump to the start of the program that is being played
“Move to end” button

Jump to the end of the program that is being played
“Play” button

Play a selected program

“Backward” button

Jump to the previous second

“Forward” button

Jump to the next second

“Jump” button

Click to open a dialogue box where you can set the playing position
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5 Advanced Operational Skills

5.1 Adding multiple DVDs

In order to save your time, DVD Ripper Platinum supports the adding of multiple DVDs in one
conversion.

If you have more than one DVD-ROM or virtual drive on your computer, all you have to do is to add
the DVDs that you wish to convert, select required profiles for different chapters or titles, and then
click the Convert button. DVD Ripper Platinum will start the conversion automatically. You can do
something else at the same time.

5.2 Customizing “Profile”

If you have modified parameters for a profile during conversion and you wish to continue to use
them in the future, DVD Ripper Platinum allows saving the modified profile as a new profile. By
doing this, you can use the new profile whenever you want.

Moreover, for the custom “Profile”, DVD Ripper Platinum provides operations such as Save,
Rename and Delete.

For more information about the “Customizing Profile”, please refer to the “How to customize
"Profile" in “Getting started”.

5.3 Supporting H.264

5 profiles that support H.264 video codecs are added to DVD Ripper Platinum’s profile list. They
are PS3 Video(1080P) MPEG-4 (*.mp4); PS3 Video(480P) MPEG-4 (*.mp4); PS3 Video(720P)
MPEG-4 (*.mp4); PS3 Video(480P) MPEG-4 HD (*.mp4) and PSP AVC Video Format (*.mp4).

By using these profiles in encoding, the encoding data speed can be up to 30Mbit/s and the
supported image pixel is ranged from 96x80 to 1920x1072, which provide you with more and
better choices.

Note: At present, H.264 video codecs have only processed macroblocks of 16. Therefore, the
width and height of a video need to be multiples of 16. For example, if you wish to output a video of
1080, please make sure that the video’s height is 1072 or 1088 and the width is 1920.

Hint: If you wish to select a profile higher than 720P, please make sure that the source is DVD disc
or folder in high definition (HD) format.

5.4 Changing the position of subtitle
With DVD Ripper Platinum, you can change the position of the subtitle of a video.
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During preview, if you find that the subtitle is not in a proper position, you can use this function to
change its position. You can also preview the results in the preview player.

Original subtitle Subtitle after being moved

For specific operations pertinent to the function, please refer to the “Preferences tab>DVD
(Global)>Subtitle” in “Operating Instructions”.

5.5 When connecting an iPod to a TV to play videos, we recommend

“iPod Video (640x480) MPEG-4 Video”

DVD Ripper Platinum provides two profiles, “iPod Video (320x240) MPEG-4 Video” and “iPod
Video (640x480) MPEG-4 Video”, to support the conversion for iPod devices.

If you wish to connect an iPod to a TV to play videos and your iPod supports 640x480, we
recommend “iPod Video (640x480) MPEG-4 Video”.

Xilisoft Corporation,2007 Page 44



6 Set profile

6.1 Supported profile

Default parameters for output files

3GPP2 - 3rd Generation Partnership Project 2 (*.3g2)

Codec: mpeg4
Video size: 176x144
Bit rate: 120

Codec: mpeg4aac
Bit rate: 48

Profile - : Remarks
Video Audio

3GPP

3GPP - 3rd Generation Partnership Project (*.3gp) Codec: h263 Codec: amr_nb Suitable for portable devices such
Video size: 176x144 Bit rate: 48 as 3G cellular phones.
Bit rate: 120 Please make your choice

according to the devices.

Dell

Dell Axim X51 (*.wmv)

Codec: wmv3x
Video size: 320x240
Bit rate: 768

Codec: wma7x
Bit rate: 128

Dell Axim X51v (*.wmv)

Codec: wmv3x
Video size: 640x480
Bit rate: 1000

Codec: wma7x
Bit rate: 128

Suitable for Dell Axim series
products.

Please make your choice
according to device models.

General Pocket PC

General Pocket PC (*.wmv)

Codec: wmv3x
Video size: 320x240
Bit rate: 768

Codec: wma7x
Bit rate: 128

General Pocket PC-Excellent Quality (*.wmv)

Codec: wmv3x
Video size: 320x240
Bit rate: 1200

Codec: wmaT7x
Bit rate: 128

Suitable for General Pocket PC
series products.

Please make your choice
according to device models.
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Default parameters for output files

Profile . :
Video Audio
General Pocket PC-Minimal Size (*.wmv) Codec: wmv3x Codec: wma7x
Video size: 176x144 Bit rate: 128

Bit rate: 300

Remarks

HP iPAQ

HP IPAQ hx4700 series (*.wmv)

Codec: wmv3x
Video size: 240x240
Bit rate: 400

Codec: wma7x
Bit rate: 128

HP IPAQ hx2000/rx3000/rx1900 series (*.wmv)

Codec: wmv3x
Video size: 320x240
Bit rate: 768

Codec: wma7x
Bit rate: 128

HP IPAQ hx4700 series (*.wmv)

Codec: wmv3x
Video size: 640x480
Bit rate: 1200

Codec: wma7x
Bit rate: 128

Suitable for HP IPAQ series
products.

Please make your choice
according to device models.

iPod

iPod (320x240) MPEG-4 Video(*.mp4)

Codec: mpeg4
Video size: 320X240
Bit rate: 512

Codec: mpeg4aac
Bit rate: 64

iPod Video (640x480) MPEG-4 Video (*.mp4)

Codec: mpeg4
Video size: 640x480
Bit rate: 1200

Codec: mpeg4aac
Bit rate: 80

For playing using iPod, 320X240
output is recommended.

For playing using TV connected
with iPod, 640x480 output is
recommended if your iPod
supports 640x480.

PS3 Video

PS3 Video(1080P) MPEG-4 (*.mp4)

Codec: h264
Video size: 1920x1072
Bit rate: 2000

Codec: mpeg4aac
Bit rate: 256

Suitable for playing using TV
connected with PS3.
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Default parameters for output files

Profile ; ;
Video Audio

PS3 Video(480P) MPEG-4 (*.mp4) Codec: h264 Codec: mpeg4aac
Video size: 720x480 Bit rate: 80

Bit rate: 1200

PS3 Video(720P) MPEG-4 (*.mp4)

Codec: h264
Video size: 1280x720
Bit rate: 2000

Codec: mpeg4aac
Bit rate: 256

PS3 Video(480P) MPEG-4 HD (*.mp4)

Codec: h264
Video size: 720x480
Bit rate: 2500

Codec: mpeg4aac
Bit rate: 256

Remarks

PSP
PSP-PSP MPEG-4 Video (*.mp4) Codec: xvid Codec: mpeg4aac Suitable for playing using PSP.
Video size: 368x208 Bit rate: 64
Bit rate: 512
PSP-PSP MPEG-4 Video-Excellent Quality (*.mp4) Codec: xvid Codec: mpeg4aac
Video size: 368x208 Bit rate: 64
Bit rate: 768
PSP-PSP MPEG-4 Video-Minimal Size (*.mp4) Codec: xvid Codec: mpeg4aac
Video size: 160x112 Bit rate: 64
Bit rate: 216
PSP AVC Video Format (*.mp4) Codec: h264 Codec: mpeg4aac
Video size: 368x208 Bit rate: 64
Bit rate: 400
Archos
Archos AV500/GMini402 (*.avi) Codec: mpeg4 Codec: mp3 Suitable for Archos series
Video size: 480x272 Bit rate: 128 products.

Bit rate: 1200

Please make your choice
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Default parameters for output files

Profile - : Remarks
Video Audio
Archos AV700 (*.avi) Codec: mpeg4 Codec: mp3 according to device models.
Video size: 720x480 Bit rate: 128
Bit rate: 2000
Other MP4 related video devices
Creative Zen Vision (*.avi) Codec: mpeg4 Codec: mp3 Suitable for playing using
Video size: 640x480 Bit rate: 128 Creative Zen.
Bit rate: 1200
iRiver PMP-100 (*.avi) Codec: mpeg4 Codec: mp3 Suitable for playing using iRiver
Video size: 640x480 Bit rate: 128 PMP.
Bit rate: 1200
MPEG1/MPEG2
MPEG-1 Movie (*.mpg) Codec: mpeg1video Codec: mp2
Video size: 320x240 Bit rate: 192
Bit rate: 1600
MPEG-2 Movie (*.mpg) Codec: mpeg2video Codec: mp3
Video size: 320x240 Bit rate: 192
Bit rate: 2000
VideoCD Format (*.dat) Codec: mpeg1video Codec: mp2
Standard: NTSC Bit rate: 224
Video size: 352x240
Bit rate: 1150
VOB - MPEG2 PS Format (*.vob) Codec: mpeglvideo | Codec: ac3
Standard: NTSC Bit rate: 448

Video size: Same as
source
Bit rate: 6000
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Default parameters for output files

Profile - : Remarks
Video Audio

Super VideoCD Format (*.vob) Codec: mpeg2video Codec: mp2
Video size: 480x480 Bit rate: 224
Bit rate: 2040

DVD - Video Format (*.vob) Codec: mpeg2video Codec: ac3
Video size: 720x480 Bit rate: 448
Bit rate: 6000

MPEG4

ASF - Advanced Streaming Format (*.asf) Codec: msmpeg4 Codec: mp3
Video size: Same as Bit rate: 128

source
Bit rate: 1200

AVI - Audio-Video Interleaved (*.avi)

Codec: mpeg4
Video size: Same as
source

Bit rate: 1200

Codec: pcm_s16le
Bit rate: Same as
source

DivX Movie (*.avi) Codec: mpeg4 Codec: mp3
Video size: Same as Bit rate: 128
source
Bit rate: 1200

Xvid Movie (*.avi) Codec: XviD Codec: mp3
Video size: Same as Bit rate: 128
source

Bit rate: 1200

MP4 - MPEG-4 Video (*.mp4)

Codec: mpeg4
Video size: Same as
source

Bit rate: 1200

Codec: mpeg4aac
Bit rate: 128
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Default parameters for output files

Profile - : Remarks
Video Audio
MPEG-4 AVC Video Format (*.mp4) Codec: h264 Codec: mpeg4aac
Video size: 320x240 Bit rate: 64
Bit rate: 768
MOV - QuickTime (*.mov) Codec: mpeg4_qt Codec:
Video size: Same as mpeg4aac_qt
source Bit rate: 128
Bit rate: 1200
WMV - Windows Media Video (*.wmv) Codec: wmv3x Codec: wma7x
Video size: 320x240 Bit rate: 128
Bit rate: 1200
RM - RealVideo (*.rm) Codec: rv10 Codec: ac3
Video size: 320x240 Bit rate: 128
Bit rate: 384
Audio
AAC - Advanced Audio Coding(*.acc) Codec: aac
Bit rate: 128
AC3 - Dolby Digital AC - 3(*.ac3) Codec: ac3
Bit rate: 192
M4A - MPEG-4 Audio (*.m4a) Codec: mpeg4aac
Bit rate: 128
MP2 - MPEG Layer-2 Audio (*.mp2) Codec: mp2
Bit rate: 224
MP3 - MPEG Layer-3 Audio (*.mp3) Codec: mp3
Bit rate: 192
OGG - Ogg Vorbis Audio (*.0gg) Codec: vorbis
Bit rate: 160
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} Default parameters for output files
Profile - : Remarks
Video Audio

RA - RealAudio (*.ra) Codec: ac3
Bit rate: 128

SUN AU Format (*.au) Codec: pcm_s16be
Bit rate: Same as
source

WAV - Waveform Audio (*.wav) Codec: pcm_s16le
Bit rate: Same as
source

WMA - Windows Media Audio (*.wma) Codec: wma7x
Bit rate: 128
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6.2

Common output property list

Parameter

Description

General

Set general encoding properties, including duration and start time.

Duration

Set encoding duration.

The default value is “full”’, which means the full duration of the source program.

If you wish to convert a portion of the program, please set the duration for the
portion.

For example, if you wish to convert the program from 00:00:50 to 00:02:50 in a title
or chapter, please set the duration to: 120s or 00:02:00.

Start Time

Set a start time for encoding.

The default value is “00:00:00”, which means the conversion starts at the
beginning of the source program.

If you wish to convert a portion of the program, please set the start time for the
portion.

For example, if you wish to convert the program from 00:00:50 to 00:02:50 in a title
or chapter, please set the start time to: 00:00:50.

Video

Set video properties for output files.

Video codec

Set video codec.

In normal cases, please keep the default settings.

For certain exceptional profiles, we provide various encoding algorithms. Please
make your choice according to your needs.

Standard

Set video standard (PAL, NTSC).
Please ensure that the setting is the same with the source program.
For example, if the source is in “PAL” standard, please set the value to “PAL”".

Video size

Set the video frame size (WxH).
It is recommended to select a value not more than that of the source program.

Bit rate

Set video bit rate (unit: Kbit/s)

After the profile is determined, the bit rate is set by default.

It can be modified according to “program properties”.

For example: if higher quality is required, then larger bit rate should be selected.
Size of the output file will be increased accordingly.

Max. Bit Rate

Min. Bit Rate

Set the peak bit rates for output programs (unit: Kbit/s).
By jointly modifying the two values, better output quality can be achieved.
Hint: Max. Bit Rate=Bit Rate(already defined) 2Min. Bit Rate

Buffer Size

Set buffer size (unit: kByte)
In normal cases, please keep the default value unchanged.

Frame Rate

Set the frame rate (Hz value, fraction or abbreviation).
In normal cases, please keep the default value unchanged.

Aspect Ratio

Set the aspect ratio for playing the program (4:3, 16:9 or 1.3333, 1.7777).

Bitrate Tolerance

Set the output bit rate tolerance, i.e., the deviation from the defined bitrate.

Same Quality

Set the option and the output program will have the same quality as the source
program.
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Disable Video Set the option and the video stream of the output program will be shielded.
Audio
Set audio codec. (If it is set to “Copy”, then the stream will be copied)
. In normal cases, please keep the default settings.
Audio codec . . , . . . .
For certain exceptional profiles, we provide various encoding algorithms. Please
make your choice according to your needs.
Set audio bit rate (unit: kbit/s)
After the profile is determined, the bit rate is set by default.
Bit rate It can be modified according to “program properties”.
For example: if higher quality is required, then larger bit rate should be selected.
Size of the output file will be increased accordingly.
Set audio sampling rate (unit: Hz)
After the profile is determined, the sample rate is set by default.
Sample rate It can be modified according to “program properties”.
For example: if higher quality is required, then larger sample rate should be
entered. Size of the output file will be increased accordingly.
Channels Set the humber of aL.JdiO channels.
Two options are available: 1 and 2.
Disable Audio Set the option and the audio stream of the output program will be shielded.
The group of parameters becomes configurable when the profile is WMV, WMA or
Summary
MP3.
Title Set the title for ID3
Author Set the author for ID3
Copyright Set the copyright information for ID3
Comments Set the comments for ID3
Album Set the album names for ID3
Genre (Style) Set the genre for ID3
Composer Set the composer for ID3
Orig, Artist Set the original artist for ID3
URL Set the URL for ID3

Encode format

Set the encoding format for ID3

Year Set the year for ID3
ID3v1 Set whether to support ID3v1 information.
ID3v2 Set whether to support ID3v2 information.
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7 Technical Support

71 FAQ

Q: Can | convert a DVD on which there is “Copy Protection”?

A: Yes.

During conversion, DVD Ripper Platinum will automatically run a background program that
decodes CSS.

Besides, before conversion, you can use the “Settings > Preferences > DVD(Global)” option to set
a CSS decoding method.

For more information about the “DeCSS”, please refer to the “References
tab>DVD(Global)>DeCSS” in “Operating Instructions”.

Q: Is ID3v2 supported?
A: Yes.

With DVD Ripper Platinum, if you have selected profiles of WMV, WMA and MP3, then you can
edit ID3 labels (including ID3v1 and ID3v2) for output programs in the output property list on the
right side of the main interface.

For more information about “ID3”, please refer to the “Common output property list” in “Set Profile”.

Note: ID3 information is the relevant information contained in an MP3 audio file, including the song
(audio)’s title, singer, album name, year, genre and comments, etc.

ID3 information has two versions, v1 and v2. V1 ID3 is located at the end of an mp3 file, sized 128
bytes and starts with three characters of TAG followed by the information about the song. V2 is
typically located at the beginning of an mp3 file, which can contain large-capacity information such
as lyrics and album images.
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Q: How to change the skin?

A: Select “Settings>Change Skin” to open the “Change skin” dialogue box, where you can choose
your favorite software skin.

[ xilisoft 0¥D Ripper Platinsm = Ox|

N Lo J[ conal ]
| Profils: MP3 - MPEG Layrer-3 Ay (".mpd) w Save Ad.,.
T Lt w Splt: | Infinde W Configas
| Dmstinstions |C:ltemp Browes.,. Lo P
= e e . O e S

After selection, click “OK” to close the dialogue box and apply the selected skin.

Q: How to change the language?

A: In the drop-down menu of “Settings>Language” option, select the desired language.

= ailisoft D¥D Ripper Platinim -ox|
pE LY -
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Getting Started B e
| Japaress Copyright
1 Click “Prodile” rombobox o choose & Comirends
| 2. Click "DV batbon 1o opsn DVD Al
3. Glick “Rip’ button o start ipping Ganre
Compaser
i, Artist
UL
iy | Ervoded by
| Vear
IDvE Tre
ID3ve T
]
2 = Audio |
| &l oo r | TR
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Profils: MP3 - MPEG Laysi-3 Ak (*.mpd) w | Savm s, ||~
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After selection, all commands, functions and items in DVD Ripper Platinum will be displayed in
the selected language.
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Q: How to view the conversion log?

A: DVD Ripper Platinum supports log view. You can easily view the conversion log during or after
a conversion.

To do this:

Step 1: Select the program that you wish to view in the program list;

Step 2: Click the E button at the right side of the status bar to open the Log dialogue box. In the

dialogue, you can find the detailed information about the program before and after conversion, as
well as problems that could be encountered during conversion.

See the figure below:

Input #0, ifo, from 'EAYIDEC_TSWTS_01_0.IFO"
Curation: 02:07:33.4, bitrate: 384 kby's
Skream #0.0: Video: ifo_v, 720x430, 29.97 fps
Skream #0.1: Audio: ifo_a, 48000 Hz, stereo, 364 kb)s
Cukput #0, mpd, o 'CTemplE--1 Title_01_014Chapter 1.mp4'
Stream #0,0: Yideo: mpegd, 320x240, 29,97 fps, g=2-31, 517 kb/s
Stream #0,1: Audio; mpegdaac, 44100 Hz, steren, 64 kh)'s
Skream mapping:
Stream #0.0 -= #0.0
Stream #0.1 ->= #0.1

Widen:23364kE Audin:5979kE Global headers:0kE Muxing overhead 0,76094 795
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Q: How to set simultaneous conversion processes?

A: Select “Settings>Preferences” to open the Preferences tab. In the General tab, set the
Maximum simultaneous processes and Maximum simultaneous running processes.

See the figure below:

Preferences rg|

General | DYD (Global)

Rip
Maximum simultanecus processes: ]|j

Maimurm simult NEous running processes: .1

[#]skip checked title in chapber mode

Previevs
Previeve window aspect ratio: 16:9 P

[#]Enable video while playing Rendering: |YUY v
[+] Enable audio while plaving

Cotput

[+] Create chapter folder in output folder
[#] Create abum Folder in output Folder

i (F, |l Cancel ]

For more information about the “Conversion processes”, please refer to the “References
tab>General” in “Operating Instructions”.
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Q: How to change the aspect ratio for the preview window?

A: Select “Settings>Preferences” to open the Preferences tab. In the Preview column of the
General tab, set an aspect ratio for the preview window.

See the figure below:

General | DYD (Global)
Rip
Maximnum simultanecus processes: 10

Madmum simult SNEoUs running processes: I

[#] Skip checked title in chapter mods

Previevw

Previeve window aspect ratio: 16:9 e

[#]Enable video while playing Rendering: |YUY v
[+] Enable audio while playing

Qb put

[#] Create chapter folder in output folder
[#] Create abum Folder in output Folder

[ 2K |l Cancel ]

For more information about the “preview window”, please refer to “References
tab>General>Preview” and “Preview player” in “Operating Instructions”.

Q: How to set zooming modes and splitting modes for videos?

A: DVD Ripper Platinum has “Zoom” and “Split” options in the output control panel on the main
interface. Using these two options, you can select your required zooming modes and splitting
modes.

To do this:
Step 1: Select the program that you wish to operate in the program list;

Step 2: In the output control panel, click to open the “Zoom” drop-down menu, and selecte the
required zooming mode; likewise, click to open the “Split” drop-down menu to select the required
splitting mode.
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After conversion, you'll get the program that you want.

For more information about “video zooming modes” and “video splitting modes”, please refer to the
“Output control panel” in “Operating Instructions”.

7.2 Contact us

If you encounter any problems during the product application, please contact us for technical
support by following method.

>  Send an email to support@xilisoft.com. Our customer service staff will give you a response

within one (1) working day.

Besides, we would appreciate it if you could attach your conversion log along with your email. It
would help us for a quick trouble-shooting.

For more information about the “conversion log”, please refer to the “FAQ”.
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8 Buy DVD Ripper Platinum

8.1 Buy aregistration code

Clicking the “Buy Registration Code* item in the drop-down menu of “Help®, you can open DVD
Ripper Platinum’s website for online purchase of the product.

Contents

Buy Registration Code
Enter Registration Code...
Feedback and Support

Aot

8.2 Registration

After purchasing, you will obtain a registration code through email. Run DVD Ripper Platinum. On
the main interface, click the “Enter Registration Code” item in the “Help* drop-down menu to open
the “Registration“ dialogue box.

Registration ['5_<|

Reqistration Info

MName: | |

License Code: | |

Buy Xilisaft DYD Ripper Plakinurn

Tech Support

Anwvtime,even vou are in trail, you have hard question,
wiou can contack our support beam at

supporbEilisaf, com

We provide free technical assistance.

| o || Later

Enter the user’s “Name” and “License Code” and click “OK* to finish the registration and close the
dialogue box.

Xilisoft Corporation,2007 Page 60



If you click “Later, you will enter into the trial version of DVD Ripper Platinum.

Hint: With the trail version of DVD Ripper Platinum, you can only convert 5 minutes or less of a
single program; if duration of the program is less than 5 minutes, you can only convert half.

In addition, the setting of “Duration” and “Start Time” will also be invalid.
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9 Annex

9.1 Introduction to Xilisoft

Xilisoft Corporation, founded on March 28, 2004, is a well-known and professional developer
dedicating to digital video and audio software developing. We develop multiple market channels
based on the Internet to the people all over the world.

Xilisoft series software products are universal video and audio conversion tools. Each individual
product with its multitude of functions has already won its reputation from users all over the world.

At present, there are 46 products from Xilisoft on the market. All products are released after
intense research.

Xilisoft Video Converter

A versatile video converter, converts between all popular video formats including DVD, VCD,
SVCD, MOV, RM, AVI, MPEG, WMV, 3GP, H.264/MPEG-4 AVC, H.264/PSP AVC etc easily,
quickly with high quality.

Xilisoft DVD Ripper Platinum
A powerful, easy to use DVD ripping software, helps you rip DVD to VCD, SVCD, AVI, MPEG, DivX,
WMV, WMA, ASF etc. ease-to-use with multi-options.

Xilisoft DVD Creator
An easy and fast DVD creating software, converts popular video formats such as MPEG, DivX,
WMV, XviD, DV, VOB, AVI to DVD and burns DVD movie played on portable or home DVD player.

Xilisoft DVD Copy Express
A stable, fast, easy-to-use DVD copying software, provides the best way to copy DVD movie with
excellent DVD copying quality.

Xilisoft Audio Maker
A multifunctional audio converter, music CD ripper and audio CD burning software, converts, rips,
and burns music CD easily, fast, with excellent quality.

Xilisoft Corporation would like to provide full multimedia solutions to meet and serve customers'
demand. We will try our best to bring users the most excellent software and technology all the
while.

Xilisoft Corporation,2007 Page 62


http://xilisoft.com/video-converter.html
http://xilisoft.com/dvd-ripper-platinum.html
http://xilisoft.com/dvd-creator.html
http://xilisoft.com/dvd-copy-express.html
http://xilisoft.com/audio-maker.html

9.2 Introduction to Xilisoft software
9.2.1 Xilisoft Ripper Pack Platinum

A pack of discount software which can convert all type of music video including FIVE popular and
excellent conversion multimedia application:

e Xilisoft DVD Ripper Platinum
o Xilisoft Video Converter

o Xilisoft Audio Converter

e Xilisoft DVD Creator

e Xilisoft CD Ripper

Free download Xilisoft Ripper Pack Platinum and have a wonderful experience now!

For full information about Xilisoft Ripper Pack Platinum, please visit:

http://www.xilisoft.com/ripper-pack-platinum.html

http://www.xilisoft.com/support.html

9.2.2 Xilisoft DVD Creator

Xilisoft DVD Creator provides an easy and fast way to convert popular video formats such as
MPEG, DivX, WMV, XviD, DV, VOB, AVI to DVD and burn DVD movie played on portable or home
DVD player.

Xilisoft DVD Creator allows you to specify NTSC or PAL, adjust 4:3 or 16:9 video aspect, setting
actions after DVD burning, and either burn DVD movie disc or DVD folder or ISO files. The DVD
Creator has many brilliant DVD menus and menu editing methods to burn DVD. It supports DVD-R,
DVD+R, DVD-RW and DVD+RW, DVD-5, DVD-9.

So easy to use and fast than ever before, just one click to burn DVD movie(convert AVI to DVD,
MPEG to DVD, DivX to DVD!) Free download Xilisoft DVD Creator and have a wonderful
experience now!

For more information about Xilisoft DVD Creator, please visit

http://www.xilisoft.com/dvd-creator.html

http://www.xilisoft.com/support.html
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9.2.3 Xilisoft DVD to iPod Converter

Xilisoft DVD to iPod Converter is powerful easy-to-use DVD to iPod converter software which
helps you convert DVD to iPod MP4 (MPEG-4), DVD to iPhone and DVD to iPod MP3, AAC, M4A
audio formats, put DVD on iPod player, iPhone mobile with great quality and super fast converting
speed!

Xilisoft DVD to iPod converter has more settings you can customize, for example, convert DVD to
iPod, iPhone video by custom file size, rip DVD's any segment, select target subtitle and audio
track. You can get adjustable quality what ever you want to put DVD on iPod player, iPhone
mobile.

Xilisoft DVD to iPod Converter is so easy to use and fast than ever before, just a few clicks are
enough to convert DVD to iPod. Free download Xilisoft DVD to iPod Converter and have a
wonderful experience now!

For full information about Xilisoft DVD to iPod Converter, please visit:

http://www.xilisoft.com/dvd-to-ipod-converter.html

http://www.xilisoft.com/support.html

9.2.4 Xilisoft DVD to MP4 Converter

Xilisoft DVD to MP4 Converter is powerful and excellent DVD to MP4 converting software which
helps you rip and convert DVD to MP4, DVD to AVI, MPEG4, DivX, XviD video format. The MP4
converter software supports the most up-to-date MPEG-4 AVC Video Format and PSP AVC Video
Format.

The output movies are playable on most of portable media players (MP4 player) such as Archos

AV500, Archos AV700, Archos GMini402, iRiver PMP-100, Creative Zen Vision, etc. Xilisoft DVD
to MP4 Converter also convert DVD to iPod movie and PSP video and rip DVD to audio formats

MP3, AAC, M4A.

The DVD to MP4 Converter has more settings you can customize. It allows you to convert DVD to
MP4 by custom file size, rip DVD's any segment, select target subtitle and audio track, and so on.

So easy and fast to rip your DVD files to MP4 video. Just a few clicks to convert DVD to MP4, AV,
MPEG4 video! Free download Xilisoft DVD to MP4 Converter and have a wonderful experience
now!

For full information about Xilisoft DVD to MP4 Converter, please visit:

http://www.xilisoft.com/dvd-to-mp4-converter.html

http://www.xilisoft.com/support.html
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9.2.5 Xilisoft DVD Copy Express

Xilisoft DVD Copy Express is stable, fast, easy-to-use DVD-copy software which provides an easy
way to copy DVD movie.

Xilisoft DVD Copy Express can entirely copy DVD movie in 1:1 ratio perfectly, and compress
DVD-9 (dual-layer DVD) to one DVD-5 disc easily. The DVD copy software also allows you to
remove DVD menus, select subtitles and audio tracks, or copy main movie separately to create
customized DVD. What's more, the DVD copy software, i. e. DVD copying program, can remove
the CSS-encryption using built-in CSS decryption program and remove the Region Codes of
movie DVDs.

The DVD copy software contains functions of DVD burning software. So it can not only copy DVD
movie to ISO file or DVD folder and backup DVD to hard disk drive, but also burn ISO file and DVD
folder to DVDs.

Free download Xilisoft DVD Copy Express and have a wonderful experience now!

For full information about Xilisoft DVD Copy Express, please visit:

http://www.xilisoft.com/dvd-copy-express.html

http://www.xilisoft.com/support.html

9.3 List of Xilisoft websites

Xilisoft English Website: http://www.xilisoft.com
Xilisoft Germany Website: http://www.xilisoft.de
Xilisoft Chinese Website: http://www.xilisoft.com.cn
Xilisoft Japanese Website: http://www.xilisoft.jp

Xilisoft Corporation,2007 Page 65


http://www.xilisoft.com/downloads/x-dvd-copy-express.exe
http://www.xilisoft.com/dvd-copy-express.html
http://www.xilisoft.com/support.html
http://www.xilisoft.com/
http://www.xilisoft.de/
http://www.xilisoft.com.cn/
http://www.xilisoft.jp/

	Introduction to DVD Ripper Platinum
	Welcome
	Features

	Install DVD Ripper Platinum
	System requirements
	Installation
	Uninstallation

	Getting started
	Starting the application
	Quick start
	How to configure DVD source file control panel
	How to customize “Profile”
	How to set the Destination
	How to view the conversion result
	How to preview programs

	Operating Instructions
	Interface layout
	Main menu
	File menu
	Edit menu
	Settings menu
	Tools menu
	Help menu

	Preferences tab
	General
	DVD (Global)

	DVD source file control panel
	Program list
	Header
	Right-click menu

	Button bar
	Output control panel
	Status bar
	Output property list
	Preview player

	Advanced Operational Skills
	Adding multiple DVDs
	Customizing “Profile”
	Supporting H.264
	Changing the position of subtitle
	When connecting an iPod to a TV to play videos, we recommend

	Set profile
	Supported profile
	Common output property list

	Technical Support
	FAQ
	Contact us

	Buy DVD Ripper Platinum
	Buy a registration code
	Registration

	Annex
	Introduction to Xilisoft
	Introduction to Xilisoft software
	Xilisoft Ripper Pack Platinum
	Xilisoft DVD Creator
	Xilisoft DVD to iPod Converter
	Xilisoft DVD to MP4 Converter
	Xilisoft DVD Copy Express

	List of Xilisoft websites


